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IntroductionIntroduction
There are number of templates available on the Internet for creating business cards. For my pur-
poses, I have a difficult time finding a template that provides the flexibility I would like. After fool-
ing around with a number of different business card creating options, I finally discovered how to 
create my own custom business cards using the free LibreOffice software.

The technique presented here involves basing the business card on a LibreOffice Label format. The 
technique also uses the LibreOffice, Frame function to control the placement of text and objects 
within the card boundaries. If you are not already familiar with the concept of frames and paragraph
styles in LibreOffice, by the time you complete this tutorial you will have added these powerful 
tools to your collection.

NOTE: I have evolved a standard format for creating my series of tutorials. You will find
general information in normal paragraphs, notes or important points shaded with the 
color of this note, and steps to be completed in shaded paragraphs.

Creating a Label BaseCreating a Label Base
✔ Open LibreOffice.

If LibreOffice has been used previously, thumbnail images of recent files will appear in the opening 
display. If this is the first time LibreOffice has been opened, a welcome message appears.

✔ From the Menubar, select File,
New, Labels.

Figure 1: Opening a new label file.
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The Labels dialog box should now be on your display. There are three tabs on the top of the dialog 
box. When the Labels tab is selected, there are drop down selection boxes for Brand and Type. 
You can select from a listing of standard label formats. 

In this exercise, the Labels dialog box will be used
to create custom labels. Once you have formatted
and saved the custom label design, the Brand and 
Type will appear in this dialog box.

✔ In the Labels dialog box, select the Options tab.

Before defining the size settings for the business cards, a couple of options will be set.

✔ In the Options section of the Labels dia-
log box, toggle the Entire page and 
Synchronize contents options ON.

✔ In the Options section of the Labels dia-
log box, select the printer Setup button.
Then select the desired printer and se-
lect Properties to set the paper source
and stock weight for your printer.

Many printers have settings for a bypass tray and
heavy card stock. I have gotten better results from
my printer by manually feeding thick paper such as
business card stock rather than using an internal pa-
per tray.

In this project, standard 8 ½ x 11 inch business card
stock will be used. Business card stock with laser
cut perforations is available from a number of different manufactures. There are ten 3.5 by 2 inch 
business cards on these pages. 

Users outside of the USA can adjust the dimensions to local standards.

✔ In the Labels dialog box, select the Format tab.
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Figure 2: The Labels dialog box.

Figure 3: Setting the Printer properties.
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✔ In the Format
section of the
Labels dialog
box, adjust the
settings as
shown in Fig-
ure 4 (1).

✔ When the set-
tings have
been adjusted,
select the Save
button (2)

✔ In the Save
Label Format
dialog box, en-
ter your label
name as the 
Brand, and My
Business Card
as the Type 
(3).

Once you have saved your label definitions, your custom label will be available in the Brand list 
the next time you create a new label.

✔ After you have saved the label settings, select the New Document button in the La-
bels, Labels dialog box (4).

This will open a new Untitled document in LibreOffice Writer. It is a good habit to immediately 
save new documents with a file name and known file location.

✔ From the Menubar, select File, Save As, select a Save In folder, and enter a File 
Name for your new document.
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Figure 4: Formatting the labels.
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Your new document should look similar to Figure 5.

Note the floating Synchronize
Labels window. This is used to
fill all ten spaces on the page
with the same contents. More
about that later. 

Next, we will work on the ba-
sic card format. To aid in con-
trolling the various areas of the
card, several Frames will be
created. Also, new Para-
graph Styles will be added
for the different types of text
used on the card.

Each of the ten divisions on
the page has an initial para-
graph in place. To see exactly
what is going on with the page
formatting, the Formatting
Marks option should be
turned on.

✔ If the non printing characters are not already displayed, from the Menubar, select 
View, Formatting Marks.

✔ To focus on the card area at the
upper left of the page, use the dis-
play zoom control slider in the
lower right corner of the display to
adjust the view factor (or select 
View, Zoom and enter a new per-
centage.

The first line of each card area will have a
paragraph, even if there are no words in the
paragraph. This paragraph will make space
at the top of the card equal to the size of the
paragraph style font. The cards in this design
will have all objects and text entries living
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Figure 5: A new Business Card.

Figure 6: Zooming on upper left card.
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inside of frames. To minimize the space between the edge of the card and the first frame, a new 
paragraph style will be created that is only 6 type points tall.

✔ If the Styles and Formatting list is not on the display, press F11.

✔ Select the small arrow near the bottom of the styles list and then select Custom 
Styles.

✔ Right click in an empty area of
the Custom Styles and Format-
ting list and then select New.

This opens the Paragraph Style dialog
box. The first thing is to create a name for
the new style, and also the name of the fol-
lowing style.

✔ In the Paragraph Style, Organizer dialog box, enter as the Name a tiny paragraph.

✔ In the Paragraph Style, Organizer dialog box, set the Next Style to a tiny para-
graph.

✔ In the Paragraph Style, Organizer
dialog box, set Inherit from to 
None.
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Figure 7: Create new paragraph style.

Figure 8: Creating a new Paragraph Style.
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✔ Select the Paragraph Style, Font
tab. 

✔ In the Paragraph Style, Font dia-
log box, set the Size to 6pt.

✔ Select OK to close the Paragraph
Style, dialog box.

Next, the paragraph style for the first para-
graph in the card will be set to a tiny para-
graph style.

✔ Click in the first paragraph in the
upper left corner of the card. Then
double click on the a tiny para-
graph style in the Styles and For-
matting list.

Because the font size is so small, the 
a tiny paragraph style might be hard
to see.

✔ Select the Synchronize Labels button and observe that the paragraph size 
changes for the first paragraph in all ten cards.
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Figure 9: Setting the font size.
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Adding FramesAdding Frames
Next, a Frame will be added to the card.

✔ Position the cursor in the first
paragraph in the upper left corner
of the card, then from the 
Menubar, select Insert, Frame,
Frame.

✔ With the Type tab selected in the
Frame dialog box, set the Width
to 1.25 and the Height to 1.9.

✔ With the Type tab selected in the
Frame dialog box, set the Posi-
tion Horizontal to Left.

In this exercise, the initial background of the
frames will be set to different colors to make
it easier to keep track of where the frames
are. The background colors can be turned off
for the final version of the card.

✔ In the Frame dialog box, select the Area tab.

✔  Select Color, then select Light 
Blue 4.

✔ Select OK to close the dialog box.

Check the size and location of the first
frame. Note that the frame contains an initial
paragraph. The paragraph style for this is 
Frame Contents, but this can be changed
to a custom paragraph style.

NOTE: To edit the settings for a frame
after it has been inserted, double click
on the border of the frame to open the 
Frame dialog box.

As mentioned earlier, frames can contain
graphic images or text. For this example, a
graphic will be inserted using one of the
LibreOffice drawing tools.

✔ From the Menubar, select View, Toolbars, Drawing.
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Figure 10: Adding a frame.

Figure 11: Selecting a frame color.
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✔ If the frame is selected (there will be grab points on the corners) click in an empty 
area of the display to deselect it.

✔ From the Drawing Toolbar, select the Symbol Shapes tool and then click on the 
Smiley Face option.

✔ Click and drag a smiley face into
the frame.

✔ To change the color of the smiley
face object, select a new Color
from the properties sidebar.

When a graphic object is selected, use
the grab points to resize the object.
Use the Graphics Toolbar options to
change object parameters.

Now for some fun.

✔ Select the Synchronize Labels
button.

OK! enough fun. Next, we will add another
frame on the right side of the card.

✔ Click outside the frame in the up-
per left card. (The a tiny para-
graph style should in the format
toolbar.)

✔ From the Menubar, select Insert,
Frame, Frame.

✔ With the Type tab selected in the
Frame dialog box, set the Width
to 2.0 and the Height to 1.9.

✔ With the Type tab selected in the
Frame dialog box, set the Posi-
tion Horizontal to Right.

✔ With the Area tab selected in the
Frame dialog box, set the Color
to Light Yellow 4.

✔ Select OK to close the dialog box.

Next, some text will be added to the new frame, and custom paragraph styles will be created for the 
text.

✔ Click the cursor in an empty area to deselect all objects.
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Figure 12: Adding a graphic image.

Figure 13: Adding a second frame.
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✔ Click the cursor in the second frame paragraph.

✔ Enter new paragraphs as follows, pressing the Enter key at the end of each para-
graph. (Don't worry if the text makes the frame too tall for the card. That will be fixed 
by defining new paragraph styles.)

➢ My company name
➢ My company slogan
➢ My name
➢ My street
➢ My address
➢ My phone number
➢ My email 

The default paragraph style will probably not be what you would like on the final card. This will be 
fixed by creating custom paragraph styles.

Creating Paragraph StylesCreating Paragraph Styles
✔ Right click in an empty area of the Styles and Formatting list and then select New. 

✔ In the Paragraph Style, Orga-
nizer dialog box, enter as the 
Name an email paragraph.

✔ In the Paragraph Style, Organizer
dialog box, set the Next Style to 
an email paragraph.

✔ In the Paragraph Style, Organizer
dialog box, set Linked with to 
None.

✔ Select the Paragraph Style, 
Alignment tab and set the Op-
tions to Center. 

✔ Select the Paragraph Style, Font
tab. 

✔ In the Paragraph Style, Font dia-
log box, set the Font to Ariel,
Bold, 10pt.

✔ In the Paragraph Style, Font Effects dialog box, set the Font Color to Blue.

✔ Select OK to close the Paragraph Style, dialog box.
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Figure 14: Creating a new paragraph style.
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✔ Place the cursor somewhere in the My email paragraph and then double click on 
the an email paragraph style.

Now that you know how to create a new
paragraph style for the email address, you
should be able to do this for each of the
paragraphs on your card. Experiment with
font styles and sizes as well as spacing
above and below paragraphs (check the tabs
in the Paragraph Style dialog box) until
things fit nicely on your card.

✔ Repeat the above process and
create new paragraph styles for;
my company name, my company
slogan, my name, my street, my
address, and my phone number.

Hint: After you have created and ap-
plied a paragraph style, right click on a
style in the Styles list and select Mod-
ify. Change the font size (or whatever) then select the Apply button to see how it 
looks. Different styles can be experimented with before 

The space on a 2 inch tall card is very limited, so you will have to be careful about fitting the de-
sired text on the card without making the font too small for people to read. After a new paragraph 
style has been created, you can right click on it in the paragraph styles list, select Modify, and 
make changes to the style. This will immediately change all paragraphs in the document that use 
this style. 

✔ One of the tabs in the Paragraph Style dialog box is Indents & Spacing. Use this to
adjust the space above or below each paragraph. 

✔ Adjust your paragraph styles until you are satisfied with the text on the card.

✔ Double click on the frame borders and remove or modify the Background or Bor-
der for the frames.

✔ Select the Synchronize Labels button to extend your card design to all cards on 
the page.

✔ Save the document.

Now that you have a basic card document, you can simply select File, Save As, change the docu-
ment file name, edit the card, and create a new card from an existing design.

The sizes of the two frames used in this example are probably not optimized for your preferred style
card. No problem, you now have the power to use File, Save As to create a new variation and then
experiment with frame sizes, borders, background colors, paragraph placement, and contents until 
you are satisfied.
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Figure 15: Creating paragraph formats.
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Observe that in the sample
shown in Figure 16, the border
sizes and background colors
have been changed. You have
the power to modify your card
as you wish.

Frame backgrounds can have
solid colors, gradients, or
graphic images. Spend some
time exploring the various op-
tions in the dialog boxes used
to create the example. Once
you have completed this exer-
cise, go back to the beginning
and do the whole thing again.
You will be amazed at how
many things appear the second
time through.

The important part of this ex-
ercise was using the 
LibreOffice Labels tool to
create the basic card layout.
After that is done, the rest of
the job is similar to most 
LibreOffice word processing
exercises.
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Figure 16: A typical card layout.
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Formatting a series of Custom CardsFormatting a series of Custom Cards
In my situation here at Bristol Village <https://bvres.org/>, there was a need to create custom cards, 
all with the same basic design, but each customized for the different members of the community. 

To make creating each new card even easier, I created custom fields for each text entry, and in-
serted Fields in the master card. Here is how it works.

✔ With the original practice labels document opened, from the Menubar select File, 
Save As, and enter a new file name.

✔ From the Menubar,
select File, Proper-
ties, then select the 
Custom Properties
tab. 

✔ Select the Add but-
ton and add an entry 
Name and Value for
each desired text
area on your card.
Then select the OK
button to close the
Properties dialog box.

NOTE: If the Custom
Properties dialog box is
closed, and then re-
opened, the properties list
will be sorted by Name.

Once the custom properties have been created, the Insert, Fields option will be used to replace 
text with a field that contains the desired information. 

✔ Remove any paragraphs from the practice card.
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Figure 17: Creating Custom Properties.

https://bvres.org/
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✔ From the Menubar, select Insert,
Fields, More Fields. 

✔ In the Fields dialog box, select
the DocInformation tab, then ex-
pand the Custom option and se-
lect CompanyName.

✔ Select the Insert and Close but-
tons.

✔ Press the Enter key to add a new
paragraph.

The Company Name text will now appear
as a shaded text area. The shading shows that it is contents from an inserted field and cannot be 
edited as normal text.

✔ Repeat the above process for the other text items in your card.

✔ Select the Synchronize Labels button to extend your card design to all cards on 
the page.

✔ Be sure to save this version of the card.

Figure 19 shows
a card with in-
serted fields. It
also shows that
custom para-
graph styles have
been created and
applied to the
different fields.

Now that you
have replaced
the text on the
card with the
contents of 
Fields, you can
generate new
cards by simply modifying the Custom Properties of each new card document.

✔ Open the card with the inserted fields and use File, Save As to create a new card.
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Figure 18: The Custom Fields list.

Figure 19: Card with inserted fields.
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✔ Select File, Properties, and edit the fields you want to change.

To change the
card text con-
tents do the fol-
lowing.

✔ Select 
File,
Proper-
ties,
open the
Custom
Proper-
ties tab,
and edit
the 
Value of
each text
field to be changed.

When you select OK, all of the text on the page will automatically be updated. You now have the 
power to generate your own customized business cards.

Here is a trick to protect the original card design from accidentally making changes.

✔ Open the folder that contains the file to protect and select that file.

✔ Right click on the file and select Properties.

✔ In the Properties dialog box, toggle the Read Only option ON.

Now if you edit the custom properties and try to save it, the system will not allow it unless you use 
the File, Save As option to save the file with a different name.

This version was edited September 9, 2021
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Figure 20: Editing Field Variables.
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